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TASK-it is an external support system designed to offload  

all unnecessary task management functions from your brain  
and give you the freedom to flow into each task  

with the power of presence. 
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Introduction 
 

 

 

 

 

 

 

 

 

“Confront the difficult while it is still easy;  

accomplish the great task by a series of small 

acts.” 

- Lao Tsu 

 
 

 

 

 

 

This is not a book for casual reading.  It’s an implementation guide.  If you’re not sure 

whether you want to implement the TASK-it system, take some time to consider your 

level of commitment before you start re-configuring Outlook on your computer. 

 

The Value of Task Management 
 

Everyone uses a task management system of some kind.  Whether you keep it all in 

your head or leave sticky notes everywhere as reminders, you have a system for 

planning, remembering, scheduling and completing tasks.  The value of a 

comprehensive task management system such as TASK-it lies in its ability to manage 

everything you do without letting anything slip through the cracks. 

 

Most people complain about not having enough time to get it all done.  Since 24 

hours is all you get each day, you can’t get more time, but a good task management 

system can help you accomplish more in the time you have. 

 

Everything you do is a task.  When you get up in the morning, take a shower, eat 

breakfast, brush your teeth and get dressed, you’re performing tasks.  You perform 

the tasks of driving to work, reading your emails, checking your voice mails, and 

handling the crises and emergencies that occur during your workday.  While it’s true 

that you don’t need a task management system to help you get dressed in the 
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morning, if you’re having a hard time getting everything done, you can use some 

help.   

 

Most people do the obvious things that are part of their routines, but are inconsistent 

in accomplishing the most important things at work and in their personal lives.  The 

value of a comprehensive task management system is that it brings you face to face 

with the important things that you need to accomplish.  Your system tracks everything 

and doesn’t rely on your memory.  It gives you an effective way of planning and 

prioritizing your tasks so the important things aren’t overlooked. 

 

A comprehensive task management system leverages your talents, skills and abilities 

and makes you more productive in every area of your life.  In essence, it helps you to 

get more value out of life. 

 

What is TASK-it? 
 

TASK-it is a comprehensive task management system based on the task features of 

Microsoft Outlook.  While Outlook’s email and calendar functions are relatively 

straightforward, the task features are confusing and somewhat obscure.  As a result, 

most people don’t use them.  Microsoft has done a great job in providing all the 

features you need to configure a great task management system, but what’s the most 

effective way to configure and use those features?  TASK-it! 

 

If you create or open an Outlook Task, you’ll find fields such as: 

 

 Due Date 

 Start Date 

 Status 

 % Complete 

 Owner 

 Total Work 

 Actual Work 

 Mileage 

 Billing Information 

 Companies 

 

Most of these fields don’t apply to the kinds of things you do every day.  These fields 

allow you to do all kinds of complex things, but the complexity tends to scare people 

away.  And for a good reason.  You don’t need a system that complicates your life 

and makes it harder than it already is to get everything done. 
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For this reason, TASK-it doesn’t use many of the task features in Outlook.  If you had 

the time and the inclination, you could probably come up with the perfect way to 

configure and use Outlook to meet your task management needs.  But who has time 

to learn all the intricacies of Outlook and design the perfect configuration and set of 

procedures?  That’s where TASK-it comes in.  It’s a simple way of configuring and 

using Outlook as a highly effective task management system that’s easily adaptable 

to anyone’s work style. 

 

There are plenty of good software packages out there, but I learned long ago that 

whiz-bang software companies come and go, and you can be left high and dry if you 

depend on them to continue to develop and support their products year after year.  In 

my opinion, you can’t go wrong with Outlook.  Software companies come and go, but 

Microsoft is here to stay.  And besides, odds are you’re already using Outlook for 

your email and calendar, so TASK-it is a no-brainer.  Just do a little tweaking based 

on the instructions in this book and you’ll be ready to move forward with TASK-it, a 

great task management system. 

 

Getting Past the Dips in the Road 
 

TASK-it is easy to implement, especially if you are already using Microsoft Outlook 

for email and/or calendar management.  The hard part is sticking with it after your 

initial startup period.  I guarantee that if you start using it, you will at some point hit a 

“dip” in the road.   

 

The dip may occur in the first week after your initial implementation, or it may not 

happen for a few months; but you will experience it.  The dip is when you realize that 

you’ve started to slack off in your task management discipline.  Maybe you notice that 

you’re starting to use sticky notes again.  You may have stopped having regular 

reviews of your  task lists.  The dip in the road is the point where you begin to 

consider dropping TASK-it and returning to your old, comfortable system. 

 

How do I know you’ll hit the dip?  I did.  Everyone does.  You should consider it now, 

because if you’re going to return to your old system anyway, you might as trash this 

book and keep doing what you’re doing.  On the other hand, if you decide to go 

through the steps of implementing TASK-it, you should consider making a long-term 

commitment to push past every dip you encounter along the road. 

 

If you decide to make that commitment, I can help you navigate through some of the 

dips you’re likely to encounter: 
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 “It just doesn’t fit my tasks and the way I work.” 

 “It’s more trouble than it’s worth.  It creates extra work for me.” 

 “I’m just not using it.  The only time I actually use it is when I force myself.” 

 “There are too many times when a computer isn’t available.” 

 “I tried it, but I just don’t like it.” 

 “I stopped using it months ago.  What’s the point of going back to it now?” 

 

This book provides solutions for all the problems mentioned above, and more.  But 

these aren’t the real issues.  When you’re in a dip, your mind uses complaints such 

as these as rationalization.  Success in overcoming the emotional power of the dip 

requires determination and the ability to ignore your mind’s complaints.  Few people 

understand this simple principle, but those who do accomplish amazing results in life. 

 

Configuring Outlook 2010 for TASK-it 
 

In order to begin using TASK-it, you will need to make some minor configuration 

changes to Outlook 2010 on your desktop or notebook computer.  Chapters 2, 3, 4 

and 9 of this book will give you the instructions you’ll need to make those changes. 

 

Note: Although the references and illustrations in this book refer to Outlook 2010, 

TASK-it works with earlier and later versions of outlook.  Some of the screens and 

menus are slightly different, but the functions are essentially the same. 

 

This book is written with the assumption that you have a working knowledge of 

Outlook.  While the features and options used by TASK-it are explained in detail, this 

is not an Outlook manual.  Depending on your level of knowledge and interest, you 

may need to refer to the Outlook help system or other documentation for more 

specifics on Outlook’s wide range of features and capabilities. 
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Chapter One: 
Time, Task & Self-Management 

 

 

 

 

 

 

 

 

 

“Dost thou love life? Then do not squander time; for 

that's the stuff life is made of.” 

- Benjamin Franklin 

 

 

 

 

Time Management 
 

Regardless of what you do, time marches on minute by minute.  Time is relentless 

and it doesn’t wait for you to catch up.  It is absolutely unmanageable.  What we call 

time management is merely a set of disciplines that if followed will allow you to get 

more done in less time. 

 

Task Management 
 

Task Management is a methodology for managing the way you accomplish tasks.  In 

discussing task management, it’s helpful to establish four working definitions: 

 

Idea:  a dream, wish or possibility 

Goal:  a specific, desired, intended outcome with milestones for its accomplishment 

Project: a set of planned actions and defined tasks aimed at accomplishing a goal, or 

a milestone within a larger goal 

Task: a defined action or unit of work that can be completed in a single session 

 

A task management system is a set of tools and processes employed in performing 

tasks.  Since tasks are necessary to complete projects, achieve goals and transform 

ideas into reality, task management is critical to making things happen.  In fact, 

everything you accomplish in life is the result of completing one or more tasks. 
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Self-Management 
 

Self-management is the necessary discipline required for you to break out of your 

natural habit patterns and effectively process ideas, goals, projects and tasks.  

Without self management, you may learn the principles of time management, but you 

won’t implement most of them.  Without self-management, your task management 

system is merely a set of conscious and unconscious habit patterns that achieve far 

from optimal results. It is your discipline in self-management that will make you 

successful in implementing the TASK-it task management system and in effectively 

utilizing it over the long haul. 

 

But don’t let me scare you off.  With a moderate amount of self-management, TASK-it 

will become an effective tool for overcoming ineffective habit patterns that have 

formed in you over the course of your life.  And you will be astounded at the results. 

 

The Power of Presence 
 

When you’re really present and in the flow of your work, it’s amazing what you can 

accomplish.   You’re focused, creative, and all your energy seems to be channeled 

into the task at hand.  Whether you’re working alone in a quiet office, or interacting 

with others in the midst of external chaos, the power of presence cuts through the 

noise.  You’re in a state of focused awareness in which you’re able to channel your 

skills and awareness for optimal results. 

 

Unfortunately, most of us have to deal with distractions.  External distractions include 

ringing phones, demanding people, impending deadlines a chaotic workplace and an 

ever-increasing workload.  For most people, however, their internal distractions are 

the greatest barrier to being present and in the flow state.  Internal distractions 

include: 

 

 Unfocused and irrelevant inner-dialogue and self-talk  

 Wrangling over what is or isn’t happening while you’re engaged in the task at 

hand 

 Worries about what might or might not happen in the future 

 Lamentations about what has happened or may have happened in the past 

 Thoughts about other tasks, projects and situations, and mental efforts to work 

them out 

 Thoughts about what you should be doing now, what you should have done in 

the past, or what you should do in the future 

 Concerns about other people’s attitudes and actions (or lack of action) 
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 Anxiety about problems and potential problems that are out of the range of 

your control 

 Ongoing commentaries from your inner-critic, your inner-parent, and your 

inner-boss 

 

In the flow state, you are present and the above-mentioned internal distractions are 

absent.  But unfortunately, most people rarely experience the power of presence.  It’s 

not within the scope of this book to teach you how to be fully present, but by 

implementing the TASK-it system, you can eliminate some of the primary sources of 

your inner distractions and experience presence and flow more often during your 

workday. 

 

Out of Your Head and into the System 
 

Your brain is a wonderful instrument for generating ideas and bringing them into 

reality, but it isn’t the best task management system.  When I give my brain the 

responsibility of remembering everything that needs to be done and managing the 

entire process, it works overtime at doing the best job it can.  Thoughts and concerns 

about what needs to be done pop up at random, and the more there is to do, the 

more chaotic and pressured the mental gyrations become. 

 

Most stressed-out workaholics suffer more from their own random, self-imposed 

internal pressures than they do from external forces.  The brain functions best when 

the extraneous details are handled and it can focus on the task at hand.  TASK-it is 

an external support system designed to offload all unnecessary task management 

functions from your brain and give you the freedom to flow into each task with the 

power of presence. 

 

But in order to achieve a successful TASK-it implementation, you must overcome the 

urge to over-rely on your brain in the task management process.  If you’ve ever 

transitioned into the role of manager from the role of individual contributor, you may 

have already experienced the tendency to continue to do it all yourself.  Effective 

managers stop doing it all themselves, and learn the arts of delegation, 

empowerment, trust and accountability. 

 

Delegate the Tracking of Your Tasks to TASK-it 
 

When you rely on TASK-it as your external support system, you stop trying to 

remember and manage tasks on your own.  When a task that you can’t do 

immediately comes to mind, enter it into the system and delegate the management of 
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the task to TASK-it.  When you delegate the tracking of the task to your system, your 

mind can be at rest, because you know TASK-it will handle the job. 

 

Empower TASK-it to Support You 
 

When you immediately enter every task into the system as soon as you encounter it, 

you empower your external support system to fully support you.  If you only go half 

way, continuing to rely on handwritten to do lists and sticky notes for some tasks, you 

strip TASK-it of its power. 

 

Trust Your System 
 

Delegation and empowerment require trust.  But the more you rely on TASK-it, the 

more you will trust the system to prevent anything from slipping through the cracks.  

That trust will bring you a peace of mind that’s impossible with any method of task 

management that relies on your memory. 

 

Hold TASK-it Accountable 
 

Hold your system accountable for doing its job.  When you do your job and 

consistently enter all your tasks, TASK-it will do its job and provide you unparalleled 

support in keeping track of everything.  Think of it as a kind of partnership.  Your 

partner will make sure that you never forget the things you need to do, and you can 

focus your attention fully on doing what you do, efficiently and effectively.   
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Chapter Two: 
Getting Started 

 

 

 

 

 

 

 

 

 

“Always bear in mind that your own resolution to 

succeed is more important than any other one 

thing.” 

- Abraham Lincoln 

 

 

 

 

 

 

 

Outlook 2007 includes some very powerful, flexible, but often under-utilized task 

management features.  Most Outlook users never use these features, or if they do, 

they eventually abandon them because they’re too complex and cumbersome.  

TASK-it gives you the power of Outlook task management without the complexity.   

 

Many of Outlook’s task features, such as percent complete and task assignment are 

not used in TASK-it. Conversely, many of the features in TASK-it aren’t obvious to 

most Outlook users, but are made available by specifically configuring your Outlook 

setup for TASK-it. 

 

In this chapter you will begin the process of reconfiguring Outlook for TASK-it task 

management.  The process is simple and straightforward, and doesn’t require much 

technical skill.  It also doesn’t require IT support or changes in your Microsoft 

Exchange Server configuration.  Everything you need to do can be done at your 

desktop with very little effort.  The real effort is in changing your habits and really 

using TASK-it after the initial setup. 
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The Four Primary Outlook Functions 
 

Outlook includes four primary functions, each providing a range of configurable 

features.  They are the: 

 

 Mail  

 Calendar  

 Contacts 

 Tasks   

 

Configuring TASK-it mainly requires changes within Tasks, although you may you 

also want to make a few configuration changes within the other Outlook functions in 

order to integrate Tasks more tightly with those functions.  In this chapter as well as 

in chapters 3, 4 and 9, you will find instructions for making these changes, along with 

tips for customizing your configuration to fit your work style. 

 

 
Figure 2-1: Outlook Tasks (TASK-it View) 
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Each of the primary Outlook functions is accessed in much the same way you launch 

a program from the shortcuts on your Windows desktop.  The icons are displayed 

either as large buttons or small icons at the bottom of the Outlook Navigation Pane 

(the left vertical section of the Outlook screen).  In figure 2-1 above, Mail, Calendar, 

Tasks and Contacts are all configured as large buttons, as is the Folder List option. 

Depending on your preferences, you can configure any of these buttons as small 

icons below the buttons by clicking on the Configure Buttons icon at the bottom right 

corner of the Navigation Pane. 

 

In figure 2-1, the Tasks button is highlighted, and Tasks is displayed to the right of the 

Navigation Pane. 

 

Working with Tasks  
 

Once you have configured Outlook for TASK-it, you will access Tasks frequently.  

You can use the Navigation Pane icons to switch between Mail, Calendar, Tasks and 

Contacts, or you can open these functions in separate windows.  By using the 

separate windows method, you can leave your Outlook windows open and switch 

between them as you would with any Windows applications. 

 

To open one of the primary Outlook functions in a new window, right click on the 

function’s button or icon (Mail, Calendar, Contacts or Tasks) and select Open in New 

Window.  If you haven’t used this feature before it may take time to break your old 

habits, but you may find it to be a more effective way of using Outlook than switching 

functions within the same window. 

 

Most people close a window by clicking on the X in the upper right corner of the 

window.  If you use that method, you will have to re-open all your Outlook windows 

each time your start Outlook.  But if you exit Outlook by selecting “Exit” from the File 

menu, Outlook will remember the windows you had open and will automatically 

reopen them the next time you start Outlook.  Once you get used to this process, the 

Outlook windows you use most will always be open and available. 

 

The To-Do Bar 
 

The Outlook To-Do Bar can be used to display your tasks side-by-side with Email, 

Calendar and Contacts.  In Chapter 9 (Configuring & Using the To-Do Bar) I will 

discuss the To-Do Bar in more detail.  In configuring Outlook for TASK-it, I 

recommend turning off the To-Do Bar in your Tasks view.   To turn it off, click the To-

Do Button on the Home tab of the Ribbon at the top of the screen and select Off. 
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The To-Do List View vs. the Tasks List View 
 

Because some people use Message Flags as a way of highlighting emails that 

require action (I don’t recommend this method), Microsoft has created a special View 

called the To-Do List.  This view allows you to view tasks and flagged messages 

together.  In the next chapter you will create a new view; the TASK-it View.  Your 

view in Outlook Tasks defines what is displayed on your screen.  Outlook is pre-

configured with a number of standard views, including the To-Do List View.  The 

Outlook Task views can be selected in the Current View section of the Home tab of 

the Ribbon. 

 

Creating a New Task in Outlook 
 

There are two primary methods of creating a new task in Outlook.  The easiest 

method is to enter the subject line of the new task directly into the first line of the 

Tasks view (it’s labeled, Click here to add a new Task).  Once you have entered the 

subject line, double click anywhere on the line and the task opens in a new window. 

 

The alternate method of creating a new task is to click on the New Task icon on the 

Home tab of the Ribbon.  This opens a new task window, and you can then enter the 

subject line along with additional information about the task.  The method you use is 

purely a matter of preference.   

 

Setting Up Your TASK-it Categories 
 

The first step in configuring TASK-it is to set up categories for your tasks.  Without 

categories, you end up with a long list of unrelated tasks that are very difficult to 

manage.  Although it’s important to take some time to come up with the right set of 

categories for your work environment and style, don’t spend too much time on it 

initially.  You can easily change and add categories on the fly any time you like.  

What is initially important is using the TASK-it format so you can effectively manage 

your ideas, goals, projects and tasks. 
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Figure 2-2: Outlook default categories 

 

Outlook  2010 is pre-configured with color categories, as shown in the Color 

Categories window in figure 2-2 above.  To view the Color Categories window, create 

a new task.  Then click on the Categorize icon. 
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Figure 2-3: Assigning a category to a new task 

 

The Categorize icon (circled in red in figure 2-3 above) is used to assign a category 

to a specific task; either an open task or any task you click on. 

 

The categories are displayed alphabetically, so the TASK-it category naming scheme 

is designed to display your categories in a logical order.  Task-it categories are 

divided into five task groups: 

 

 Primary Tasks 

 Action Tasks 

 Projects 

 Goals  

 Ideas 
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By assigning one or more categories to each task, TASK-it gives you the ability to 

work from small, categorized task lists.  This makes the process of task management 

much easier than working from one long task list. 

 

Primary Tasks 

 

Your Primary Tasks group includes the tasks you plan to do right away (generally 

today).  I recommend including only one category in this group: Today’s Tasks. 

 

Your TASK-it daily To-Do list will be every task in the Today’s Tasks category.  At the 

beginning of each day (or at the end of the previous day), you will review your tasks, 

and decide what you need or want to accomplish that day.  To add a new task to your 

Today’s Tasks list, you simply assign the Today’s Tasks category to the task.  To 

place an existing task in the list, click on the task, then click on the Categorize icon 

and assign the Today’s Tasks category. 

 

One or more categories will already be assigned to each existing task.  It is not 

necessary to uncheck the other categories before assigning the Today’s Tasks 

category.  In fact, as you learn more about TASK-it you will find that assigning two or 

more categories to a task can be of considerable help in your task management 

process. 

 

Based on the nature of your work, you may decide to create one or more additional 

Primary Tasks categories, but since the number of tasks you can complete in a day is 

limited, I think you’ll find that the Today’s Tasks category is all you’ll need. 

 

Action Tasks 

 

Whereas Today’s Tasks is a group consisting of a single category, the Action Tasks 

group consists of multiple Action Task categories.  In the Action Tasks group you will 

create categories that correspond to the kind of work you do.  For example, when I’m 

not training or speaking at a conference, I spend a considerable time developing 

workshop content, writing, making travel arrangements, performing marketing tasks 

and developing/managing my websites.  Each of these functional work areas is a 

category in my Categories list.  Some of my other action categories are: Collections, 

Make DVDs for Clients, To Buy + Errands, and To Do – General.   

 

When I sit down to book hotels, airline tickets and rental cars, I always check my 

Travel Arrangements list so I can make efficient use of my time and book several 

rental cars, airline tickets or hotels in the same work session.  I often video my 

training workshops and provide DVDs of the training sessions for my clients.  In order 
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to make a DVD, I have to copy the video files to my computer, perform minor editing 

and output to DVD format.  It’s much more efficient for me to do several DVDs at 

once, so I review my Make DVDs for Clients list before I start, so I don’t overlook any 

DVDs that need to be sent to clients. 

 

What are the most common types of work that you do?  Think in terms of batching 

your work.  If I need to drive to the office supply store to pick up a case of paper, what 

else can I do while I’m running errands?  Before TASK-it, I would often remember 

something else I needed at the office supply store after I returned to my office.  Now I 

consult the To Buy + Errands list on my smartphone while I’m running errands to 

make sure I don’t forget anything. 

 

I include a Waiting category in my Action Tasks group.  Any time I’m waiting for 

someone else to do something for me, I create a task and assign the Waiting 

category so I’ll remember to follow up if necessary. 

 

Projects 

 

Although TASK-it isn’t a project management system per se, it can be a tremendous 

help in tracking the tasks you need to perform in completing your projects.  When you 

begin planning a new project, you will create a new category in the Projects Group for 

that specific project.  Then, as you come up with tasks related to that project, you will 

create each task and assign the corresponding project name category within the 

Projects Group. 

 

Many of my projects are somewhat repetitive in terms of the kinds of tasks I must 

perform.  For example, when I book a new training workshop, I create a new project 

category corresponding to the name of the client.  For each training workshop, I must 

do a certain set of tasks, including developing the customized workshop, booking 

travel arrangements, sending out contracts and invoices, etc.  So I have developed a 

project template for each type of repetitive project I undertake.  My New Workshop 

template includes the tasks I always perform for each workshop, making it faster to 

get rolling on a new project, and assuring that I won’t forget to include important 

steps. 

 

I assign an Action Tasks category to nearly every project task.  I also assign the 

specific project category in the Projects group to each task.  This forms a list matrix 

that allows me to manage tasks by project or by specific action.  When I want to 

spend a block of time making travel arrangements, I work with my Travel 

Arrangements list, providing me with a list of travel-related tasks that cuts across all 
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projects.  When I want to see what tasks remain undone on a project, I work with the 

project list for that project. 

 

When you assign more than one category to a task, Outlook doesn’t create multiple 

tasks.  Although the same task appears in each category list, there is only one task in 

the database.  When you complete a task, you can mark it complete while viewing it 

in an Action list or a Project list, and it will disappear (or display as completed, 

depending on the properties you define for completed tasks) from all lists.  When you 

complete all tasks within a project you can remove the project from your Category 

List to keep the list as short as possible. 

 

Goals 

 

The Goals Group typically consists of only one category: Goals.  If you have a long 

list of goals, you may want to consider creating additional goal categories, such as 

personal goals, career goals, work goals, family goals, financial goals, spiritual goals, 

community goals, etc. 

 

Each goal initially consists of only one task.  Since Outlook allows you to enter a 

virtually unlimited amount of text in the description field, you can use this field to 

describe the goal, its milestones, and any kind of narrative you like.  Once you’re 

ready to begin actually working on achieving the goal, you will create one or more 

projects related to the goal.  The Goals category as well as the specific Projects 

category or categories will be assigned to each task. This allows you to manage 

tasks by Goal as well as by Project.  The same methodology can be used when small 

sub-projects are a part of a larger project. Action categories can also be assigned to 

the tasks within sub-projects, projects and goals, allowing you to view your work from 

many different angles. 

 

Does every project need an associated goal?  Only if it helps you to manage the 

project.  The goal of each of my workshop projects is implicit in the project itself, so I 

don’t create corresponding goals.  

 

Ideas 

 

If you’re like me, you can come up with a new idea any time, any place.  I used to 

maintain physical files of ideas.  Sometimes I would attend a seminar or conference, 

and take notes as the speaker was talking.  Then I would bury the notes in the 

conference binder and put it on a bookshelf.  Contained in my notes and in my files 

were some great ideas, but they were difficult to access and develop. 
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Now I enter new ideas in TASK-it and assign the Ideas category.  Typically each idea 

is outlined within a single task.  If you have a lot of ideas, you can create additional 

Ideas categories, by topic.  Some ideas never go anywhere, and in your monthly task 

list reviews you may decide to delete them.  But good ideas often need incubation 

time, and your monthly task review keeps these ideas alive. 

 

I recently purchased a Tablet PC.  Now, when I attend a meeting or conference, I 

take handwritten notes and draw diagrams using Microsoft OneNote and the Tablet 

PC stylus.  Then, if there are good ideas within my notes, I convert them into tasks 

and assign the Ideas category.  When I double click on the task, all my handwritten 

notes and drawings are stored within the task, and I can add any additional notes that 

may occur to me during my review sessions. 

 

Adding TASK-it Categories to the Outlook Categories List 
 

TASK-it categories are designed to display in a specific order: 

 

 Today’s Tasks group 

 Action Tasks group 

 Projects group 

 Goals group 

 Ideas group 

 

You will precede each Task Category with a 3-character code as in figure 2-4 below 

in order to maintain the proper sort order.  So, for example, the 3-character code for 

your Today’s Tasks category (or categories) is 1, colon, space (1: ).  This category 

naming convention, along with a few changes to Outlook’s Current View settings 

(covered in Chapter 3) will allow you to effectively manage your tasks in sorted, 

organized lists. 

 

You will create your new TASK-it categories from the Color Categories window.  To 

get there, open a new task (File, New, Task) and click on the Categorize icon in the 

Task ribbon.  Then click on the New button.  In the New Category window, enter the 

category name (use the appropriate TASK-it prefix: A: , P: , etc.).  A color can be 

added to the category for visual identification and grouping purposes.  For frequently-

used categories, you can select a keyboard shortcut to bypass the menu steps when 

assigning the category. 

 

While you’re in the Color Categories window, make sure you delete all of the Outlook 

pre-configured categories.  To delete a category, click on the category and then click 

on the Delete button, then click Yes. 
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Figure 2-4: Creating your new TASK-it Categories 

 

After you have entered your categories, enter a few tasks and assign your new 

categories.  It’s easy!  When assigning one category, select it from the Color 

Categories window.  When assigning multiple categories, select All Categories and 

check the categories you want to assign. 

 

After assignment, categories appear as colored bars above the Subject line in the 

open task.  To add or change categories, double-click on the category bar to display 

the All Categories list.  From the All Categories list, you can rename a category, 

delete it, change its color, or assign a keyboard shortcut.  

 

After you have entered some categories and tasks, you’re ready to configure your 

TASK-it view. 
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Chapter Three: 
Configuring Your TASK-it View 

 

 

 

 

 

 

 

“We forget that every good that is worth possessing 

must be paid for in strokes of daily effort. We 

postpone and postpone, until those smiling 

possibilities are dead.” 

- William James 

 

 

 

 

The Outlook Tasks Current View 
 

In Outlook, your View is the main area of the screen, below the toolbars and to the 

right of the Navigation Pane.  In each of the four primary Outlook functions (Mail, 

Calendar, Tasks, Contacts, etc.) you have the ability to configure your own custom 

Views. 

 

Your initial Outlook 2010 configuration includes a number of preset Current Views 

that can be selected by clicking the appropriate icon in the Current View section of 

the Ribbon (Home tab).  The standard Outlook Tasks Current Views include: 

 

 Detailed 

 Simple List 

 To-Do List 

 Prioritized 

 Active 

 Completed 

 Today 

 Next 7 Days 

 Overdue 

 Assigned 

 Server Tasks 
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Most of these Views, in their default configuration, are not useful in working with 

TASK-it.  But with slight modification, some of these views can be very helpful.  We 

will modify the Detailed view and make it your primary TASK-it view.  Afterwards, we 

will copy the modified Detailed view, creating a new view, so that it can serve as a 

backup view if the Outlook default views are accidentally restored. 

 

 
Figure 3-1: Making a copy of the Detailed view 

 

 

You may find it useful to modify some of the other standard views and use them from 

time to time.  This chapter will show you how to make the necessary modifications.  

 

Creating Your Primary TASK-it View 
 

To create your primary TASK-it view you will modify the standard Detailed view.  

Select the Detailed view in Tasks by clicking on the Detailed icon in the Current View 

section of the Home tab in the Ribbon.  Then right click on the Detailed icon and 

select View Settings.  The Advanced View Setting: Detailed dialog box appears, 

which, among other things, gives you the ability to: 

 

 Group the View by Category 

 Display the columns you want to see 

 Sort the tasks within each category  

 Filter completed tasks from the view 
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Grouping Your primary TASK-it View by Category 
 

To Group by Categories, click the Group By button, select Categories from the drop-

down list, make sure the Ascending option is selected and then click OK.  This 

change will display your tasks by category, which is critical for managing your tasks 

and projects with TASK-it. 

 

 
Figure 3-2: Group by categories 

 
Outlook Task Fields Used by TASK-it 
 

Task fields are data elements pertaining to a task.  When you define your primary 

TASK-it view, you determine which columns to display.  So if you display the Subject 

column, your view shows the Subject field for each task in the Subject column.  Many 

of Outlook’s task fields, such as Start Date, % Complete, Total Work, Actual Work, 

Mileage, Billing Information and Companies are not used in TASK-it.  Actually, you 

will only display five fields (columns) in your primary TASK-it view:  

 

 Complete 

 Priority 

 Attachment 

 Subject 
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 Due Date 

 

The Complete Field 

 

The Complete field is a one-character field that you check when you complete the 

task.  In Outlook’s default Detailed view, completed tasks are displayed with a line 

through the task.  Later in this chapter, we will create a rule to remove completed 

tasks from the primary TASK-it view to keep the screen uncluttered.  We will also 

show you how to display the completed tasks when you want to see them. 

 

The Priority Field 

 

The Priority field is a one-character field that allows you to assign one of three priority 

levels to a task.  The default is Normal priority. By clicking on the field, you can select 

High to raise the priority of a task or Low to lower the task’s priority. 

 

The Attachment Field 

 

Since you can attach files to a task, it is helpful to see whether a task has an 

attachment.  If you have limited storage space, attachments can be a problem since 

they are usually larger than the task itself.  So having the Attachment field in your 

view allows you to quickly do a visual scan for files that can be deleted. 

 

The Subject Field 

 

The Subject field is your summary description of the task.  In many cases the subject 

field will be all you’ll need to describe the task.  If you open the task, the Notes field 

gives you a large scrollable area for additional task description. 

 

The Due Date Field 

 

It isn’t necessary to include a due date with each task, but for tasks with a specific 

deadline it’s helpful to use the Due Date field.  The reason TASK-it doesn’t use the 

Start Date field lies in the definition of a task: a defined action or unit of work that can 

be completed in a single session.  By that definition, tasks are generally started and 

completed in the same day.  If you have a task that can’t be completed in a single 

session, it should be defined as multiple tasks within a project. 
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Displaying the Columns You Want to See 
 

The columns (fields) to be included in your primary TASK-it view are Complete, 

Priority, Attachment, Subject and Due Date.  If the Advanced View Settings: Detailed 

dialog box is still on your screen, select columns (to get back to the Advanced View 

Settings: Detailed dialog box, right click on the Detailed icon in the Current View 

section of the Home tab on the Ribbon). 

 

 
Figure 3-3: Select columns to display in the primary TASK-it View 

 

The Show Columns dialog box should now be displayed.  Select Frequently-used 

Fields from the Select Available Fields drop-down box.  Select Complete, Priority, 

Subject and Due Date one at a time from the list of Available Columns and use the 

Add button to add them to the Show these columns in this order list on the right (see 

figure 3-4 above).  Use the Remove button to remove the extra fields from the Show 

these columns in this order list.  Then use the Move Up and Move Down buttons to 

put them in the correct order: 

 

 Complete 

 Priority 

 Attachment 

 Subject 
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 Due Date 

 

Then click OK, and your columns are set for your primary TASK-it view.  

 

Sorting the Tasks within Each Category 
 

The sort feature allows you to choose the order in which your tasks are displayed 

within each category.  My suggestion is to sort by Due Date and then by Priority.  

After you have used TASK-it for a while, you may want to change the sort order or 

add more sort levels.  

 

To sort your tasks by Due Date and then by Priority within each category (figure 3-5), 

click on the Sort button in the Advanced View Settings: Detailed dialog box (to get 

back to the Advanced View Settings: Detailed dialog box, right click on the Detailed 

icon in the Current View section of the Home tab on the Ribbon). In the Sort window, 

select Due Date and check Ascending. Then, in the first Then by section, select 

Priority and check Descending.  Then click OK.   

 

 
Figure 3-4: Sort by Priority 
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Filtering Completed Tasks from the TASK-it View  
 

Your final step in customizing your primary TASK-it view is to filter completed tasks.  

It might give you a great feeling of accomplishment to look at all the tasks you’ve 

completed, but  it clutters your lists too much to make it part of your primary TASK-it 

View.  After you make this configuration change you won’t see your completed tasks, 

but if you ever want to display them I’ll show you how after you finish this step. 

 

 
Figure 3-5: Filter completed tasks from the TASK-it View 

 

To filter completed tasks return to the Advanced View Settings: Detailed dialog box 

and click on the Filter button to display the Filter dialog box.  Then click on the 

Advanced tab and click on the Field button.  Select Frequently-used fields, Complete.  

Then set Condition to equals and set Value to No.  Click the Add to List button and 

then click OK and you’re done.   

 

Your TASK-it View is Ready to Roll 
 

Now your Detailed view is your primary TASK-it view, and you’re ready to go to the 

next step.  But first, I recommend that you create a duplicate of this view with the 
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name TASK-it.  This will eliminate the need to re-create the view if the defaults get 

restored. 

 

To create a duplicate view, click the View tab in the Ribbon and select Change View 

in the Current View section.  Then select Save Current View As a New View.  Enter 

TASK-it as the name of the new view, make sure All Task Folders is selected and 

click OK. 

 

If you would like to have the option to display your TASK-it view with completed 

tasks, copy the view again, giving the new view the name TASK-it + Complete.  Then 

select the new view as your current view and return to the Advanced View Settings: 

Detailed dialog box.  Click the Filter button, click the Advanced tab, select the 

Complete equals No filter you created in the previous step and click Remove.  Then 

click OK and you now have a TASK-it view that will display all tasks + completed 

tasks. 

 

After you have been using TASK-it for a while you may want to look at all the default 

views.  If any of them are useful, you can use these procedures to customize them to 

your needs. 

 

But there’s no need to spend any more time configuring Outlook now. The TASK-it 

view you just created is all you really need to get started, so stop trying to remember 

everything you have to do; you’re ready to roll!  If details about tasks, projects, goals 

and ideas pop into your head, just TASK-it! (Translation: enter them as tasks into the 

system)
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Chapter Four: 
Entering Tasks into the System 

 

 

 

 

 

 

 

 

 

 

 

“No one can cheat you out of ultimate success but 

yourself.” 

- Ralph Waldo Emerson 

 

 

 

 

 

 

 

 

 

Creating a New Task  
 

The easiest way to create a new task is to fill in the Subject line in the Click here to 

add a new Task field at the top of the Tasks View.  Then double click to open the task 

window, and enter Priority, Notes, Due Date and possibly a reminder if appropriate.  

Don’t forget to click on the Categorize icon to assign the appropriate category (or 

categories).  Then click Save and Close and your task is saved. 

 

If you have existing saved documents that you would like to attach to your task, such 

as an Excel spreadsheet, a diagram or a Word file, just click the paperclip icon on the 

toolbar or select File from the Insert menu. Outlook will store a copy of the file, and 

the shortcut will appear in the Notes field in the task.  You can also drag and drop 

files, emails and other items into the Notes field of a task. 
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Figure 4-1: A task with an assigned category 

 

Creating a Task from an Email 
 

Many Outlook users use Mail as a type of task management system.  Since emails 

often include inherent tasks, they allow these emails to remain in their inbox, adding 

to the clutter.  Outlook provides a very helpful feature that allows you to create a task 

directly from any email.  This allows you to keep all tasks in TASK-it where they 

belong. 

 

To create a task from an email, begin in Outlook Mail and click on the specific Mail 

Item to highlight it.  Then drag it to the Tasks button or icon in the Navigation Pane.  

Outlook will then open a new task, place the subject of the email in the Subject field 

of the task, and the body of the email in the Notes field of the task.  You can 

accomplish the same result by right clicking on the Mail Item and then selecting Move 

to Folder, Tasks. 

 

If your email has one or more attachments, the attachments won’t be included in the 

new task if you use the above method.  However, you can copy and paste the 

attachment from the email to the task.  To have Outlook automatically save the 

email’s attachments as part of the newly-created task, drag the Mail Item to the Task 
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button or icon in the Navigation Pane while holding down the right mouse button 

(instead of the left mouse button as you would normally do to drag and drop an 

object).  When you release the right mouse button over the Task button or icon, a 

menu will display.  Select Copy Here as Task with Attachment from the menu, and a 

new task will open with the email text and attachments in the Notes field of the new 

task. 

 

 
Figure 4-2: A new task created from an email 

 

Creating a Task from a Calendar Item 
 

If you have scheduled an appointment and need to do some preparation prior to the 

meeting, you should create a task in TASK-it to ensure that the task will be 

accomplished by the appointment date.  An easy way to do this is to drag the 

Calendar Item to the Task button or icon in the Navigation Pane.  All the tips for 

creating a Task from an email in the previous section apply when creating a task from 

a Calendar Item. 

 

Conversely, if you create a task and want to turn it into a calendar entry, you can drag 

the Task Item to the Calendar button or icon and fill in the appointment time.  This is 
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a handy feature for scheduling an appointment with yourself to complete an important 

task. 

 

Creating a Task with Your Smartphone 
 

If you travel as much as I do your computer isn’t always available when you want to 

create a new task.  Nearly every smartphone comes with the ability to synchronize its 

calendar, mail, contact and task items with Outlook.  And if it doesn’t you can buy an 

add-in software module to get this valuable feature. 

 

With my smartphone, which runs Android 2.3, I use a third-party app that allows me 

to create new tasks and assign the same categories I created on my computer.  After 

you finish your TASK-it setup on your primary computer, the first time you run your 

sync program, the TASK-it settings, categories and newly-created tasks will be 

replicated on your smartphone. 

 

Recurring Tasks 
 

If you have tasks that recur daily, weekly, monthly, quarterly or yearly, you can set 

them up as Recurring Tasks.  Create your task as normal and while the task window 

is open, click the Recurrence button on the Outlook toolbar.  The Task Recurrence 

dialog box gives you the flexibility to set up the recurrence in just about any way you 

like. 

 

So, for example, if you send out a monthly newsletter on the 15th of every month, 
your November 15 task will be created automatically, as will your December 15 task 
and your January 15 task.  By assigning the appropriate category to your recurring 
task, each month’s new task will be created in the correct TASK-it format 
automatically.  Once your new monthly task is created, it is treated exactly like a 
manually-created task, and stays in your task list(s) until you click the Complete field. 
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Figure 4-3: Creating a recurring task 

 

Make Your Initial Task Collection and Input a Priority 
 
Now that you know how to input tasks, the quicker you collect all your tasks and get 
them into the system, the better.  Make this a high priority during the next few days.  
See Chapter 10 for tips on getting all your tasks into the TASK-it system. 
 

So what are you waiting for?  Gather up your paper based To Do lists, sticky notes 

and the contents of your physical and email inboxes and begin the process of 

converting to your new system.  You have only one choice to make about each item, 

either do it now or TASK-it! 
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Chapter Five: 
Managing Your Tasks 

 
 
 
 
 
 
 
 
 

“I don't wait for moods. You accomplish nothing if 

you do that. Your mind must know it has got to get 

down to work.” 

- Pearl S. Buck 

 

 
 
 
 
 
 
 

Now that you have begun entering tasks into the TASK-it system, it’s time to learn 

how to manage those tasks.  Your Tasks View is your master task list, and each 

category is a specific sub-list.  You can display your lists on your computer or 

smartphone screen, or you can print any list if you prefer working with a hard copy. 

 

Printing Your Task Lists 
 

You can print your entire master task list by Print from the File menu.  All tasks will 

print exactly as they are displayed in your Tasks Current View, so if the tasks in any 

list (category) don’t print, click on the plus (+) icon on the category line to display all 

tasks in that category.  The best way to print your master task list is to select 

Expand/Collapse Groups, Expand All Groups from the View menu just before you 

print. 

 

To print any individual list, click on the category line at the top of the list.  Then select 

Print from the File menu.  You can select multiple categories by holding down the 

CTRL key and clicking the categories to print. 
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I recommend managing your lists directly on your PC or smartphone so you can 

make immediate changes wherever necessary.  When that’s not possible, you can 

work from the printed list and make updates to TASK-it when you get access to your 

computer. 

 

Daily Planning and Task Review Sessions 
 

One of the most productive habits you can develop is the habit of conducting a daily 

planning and task review session with yourself.  You can hold the session first thing 

in the morning, or in the evening, for the next day.  When you do it isn’t important - as 

long as you do it.  Most people begin their work day by jumping into email, voice mail, 

their inbox, or a variety of other obvious tasks, and then one thing leads to another 

and before they know it the day is over.  In my time management workshops, I work 

with hundreds of people every month to help them improve their personal 

productivity.  But effective time management isn’t about learning something new, it’s 

about replacing old work habits with new, more productive habits.  If you aren’t 

holding daily planning sessions every day, let TASK-it be the catalyst to help you 

form this new, productive habit. 

 

Your daily planning session is your opportunity to visualize your day, including your 

appointments, obligations and the tasks you need or want to perform.  With TASK-it, 

you have a powerful tool for making your daily planning sessions even more 

productive.  When fully-implemented, the TASK-it system will list every task you 

intend to do.  Tasks will no longer remain hidden in emails, in your inbox, within 

stacks of papers, in binders, in drawers and in closets.  But to be effective in 

prioritizing, scheduling and performing these tasks, you must conduct daily task 

reviews. 

 

Your daily planning and task review sessions can take as little as ten minutes, but 

they will become the most important minutes of your day.  During the session you will 

update your Today’s Tasks list.  As with any manual to do list, you will not always 

complete all tasks on your list every day.  So the undone tasks from the previous day 

will be the first items you’ll see as you begin your task review.  In order to effectively 

plan your day, you need to review: 

 

 The appointments in your calendar 

 Additional appointments or meetings you need to schedule 

 The tasks in your Today’s Task list 

 The tasks in your Action Tasks group 

 The tasks in your Project Tasks group 
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If you are conducting planning and review sessions daily, you’ll be amazed at how 

quickly you can review your appointments and tasks and visualize your day.  The 

Outlook To-Do Bar  (explained in Chapter 8), can be a great help in conducting your 

planning and review sessions, allowing you to review your calendar and tasks on the 

same Outlook screen. 

 

In updating your Today’s Tasks list, you may decide to leave all tasks remaining from 

the previous day on the list, but if you see the same tasks in your list day after day, 

you have a problem.  It could be that these “tasks” are really projects disguised as 

tasks.  Remember, if you can’t complete a task in a single session, treat it as a 

project and break it down into smaller tasks.   

 

It could be that the tasks that carry over from day to day just aren’t that important.  

Uncheck the Today’s Tasks category, and the task stays in your TASK-it system, 

listed in its appropriate Action Tasks or Project Tasks list(s).  Just because you put it 

on your Today’s Tasks list at a point in time doesn’t mean it must remain there until 

you get it done.  With manual to do lists, there is the tendency to carry items over day 

after day because of the feeling that if you remove them, they’ll never get done.  But 

with TASK-it and your planning and review sessions, nothing will ever slip through the 

cracks. 

 

Your task reminders will alert you to any task with today’s date as the due date, and 

any past-due tasks will appear in red, so you can’t miss them.  

 

During your daily planning and task review session you may decide to schedule a 

block of time on your calendar as task time, for completing a group of specific tasks 

on your Today’s Tasks list or for simply tackling the whole list.  Task time 

appointments are great for knocking out large numbers of tasks in a single, 

uninterrupted session.  Obviously, you can’t guarantee that by scheduling an hour of 

task time on your calendar you won’t be interrupted. But by consistently planning 

blocks of task time, you will get more done than by flying by the seat of your pants. 

 

On some days you’ll be unexpectedly bombarded by emergencies and unavoidable 

interruptions that derail your daily plan.  On other days, meetings and appointments 

are cancelled and you find extra task time.  TASK-it helps you to continually regroup 

and make the best of every situation.   

 

A high priority task on my Today’s Tasks list may be to buy an airline ticket to San 

Francisco for a speaking engagement.  While I’m on the Delta website buying the 

ticket, a quick review of my Travel Arrangements list (in my Action Tasks group) will 

let me know if I need to buy any other airline tickets. 



 

 

Chapter Five: Managing Your Action Tasks 

 

 

 
43 

 

Another task on my Today’s Tasks list may be to send an invoice to a client.  While 

processing the invoice, I get a vague feeling that I need to do something else for the 

client, so I quickly check my project list for the client’s workshop.  I realize that the 

due date for sending assessments to the workshop participants is tomorrow, so I get 

the jump on the task and do it today since some extra time has opened up. 

 

As you begin using TASK-it you will find that it’s one of the most powerful tools you 

have for making each day a productive experience. 

 

Monthly Planning and Task Review Sessions 
 

I recommend that you conduct a full review of your task list once a month, including 

the tasks in your Goals group and Ideas group.  You will find that it’s during these 

monthly sessions that your ideas turn into goals and your goals grow into projects.  

As you review existing projects and tasks, new tasks will come to mind, so your task 

list is bound to grow as a result of these sessions.  On the other hand, it’s the perfect 

time to delete tasks that are no longer relevant, or that you have completed but never 

checked the Complete box. 

 

Your monthly task review is the perfect time to make adjustments to your TASK-it 

categories.  Do you need new Action categories?  Can you see new projects on the 

horizon that need Project categories in your Projects group?  Your monthly planning 

and task review sessions will help you to reorder and reprioritize tasks, adjust due 

dates, and generally keep your TASK-it system tuned up and functioning properly.  

These sessions will also help you to visualize the coming month so you can gear up 

for what you need to accomplish. 

 

Using TASK-it throughout Your Workday 
 

The more you use TASK-it the more you will rely on it as your external support 

system.  Your brain is equipped with amazing mental facilities including short and 

long-term memory.  But your recall facility doesn’t always work as perfectly as you 

would like when you really need it.  And the more you try to rely on your memory for 

important information, the more your mind tends to “haunt” you with all the important 

loose ends that need to be dealt with. 

 

TASK-it offloads the task storage and retrieval functions from your brain to a highly 

reliable external support system that you can use as a tool any time you: 

 

 Come up with a new idea you want to remember 
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 Realize there is something you need to do, but can’t do it immediately 

 Have a disruption in your day and need to regroup 

 Need to review the undone tasks within a project 

 Want to brainstorm new ideas 

 Find some extra time in your day and want to make it productive 

 Want to reprioritize the tasks within your day 

 Start a task, and want to accomplish related tasks in the same work session 

 Want to do some short or long-range planning 

 Find yourself on an errand and wonder if there’s something else you need to 

do while you’re out 

 

Any new tool, process or system seems cumbersome and unnatural at first.  That’s to 

be expected.  But if you stick with it, you’ll learn to rely on TASK-it, and you’ll 

continually find new ways to use your external support system throughout your 

workday. 

 

Using TASK-it for a More Effective Personal Life 
 

Your tasks don’t end when you go home from work.  Unless the organization you 

work for has specific rules against it, the same TASK-it system you use at work is 

perfect for managing your personal tasks.  Even if it’s not allowed, you can set up a 

personal TASK-it system on your home computer. 

 

TASK-it allows you to manage your personal time more effectively, and may be the 

first tool you’ve ever used for personal task management.  Most people never 

graduate from random to do lists on scraps of paper, and they wonder why they 

never seem to have enough time to get it all done at home. 

 

Set up a personal To Do list category in your Action Tasks group (“A: To Do – 

Personal”), and you immediately have a place to separately track your personal 

tasks.  If you decide to set up a separate personal system for your personal tasks but 

want to keep it on the same computer, you can create a separate Outlook Personal 

Folder (.pst file) on your hard drive.  Then you can access it with a single click in the  

My Tasks section in the Outlook Navigation Pane.  If you want to access it on your 

work and home computer, create it on a USB drive and carry it with you between 

home and work. 

 

Don’t let technology or physical logistics keep you from implementing TASK-it for 

your personal life.  Outlook and today’s computer technology make it possible to 

solve just about any TASK-it logistical problem you can come up with. 
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Keeping track of the things you need to do, planning, prioritizing and managing your 

time are as important in your personal life as they are at work because all your time is 

valuable.  Although there are more workaholics in the world today than ever before, 

most people do have a life outside of work.  Ineffective personal task management 

can result in a frustrating, chaotic home life or a general lack of accomplishment.   

 

TASK-it can help you to eliminate disorganization and clutter, keep the promises you 

make to yourself and others and make sound priority decisions about what you’re 

going to do and when you’re going to do it.  Often the most important things get 

crowded out by less important, more demanding daily personal tasks.  TASK-it is an 

effective tool for managing your personal and family goals and priorities so you get 

what you want out of life.  Just as with your work tasks, the more you use TASK-it in 

your personal life, the more you will grow to depend on this valuable external support 

system. 
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Chapter Six: 
Managing Projects 

 
 
 
 
 
 
 
 
 

“Nothing is particularly hard if you divide it into 

small jobs.” 

    - Henry Ford 

 
 
 
 
 
 
 

The Role of TASK-it in Project Management 
 

If you need a project management system, use Microsoft Project or one of the many 

software packages that can help you develop network diagrams, determine your 

critical path and manage all aspects of your projects. 

 

But even project managers find TASK-it an effective tool for managing tasks and 

small projects that don’t fit the standard project management profile.  Years ago I 

managed teams of software project managers, and TASK-it would have been a 

perfect tool for everyone on my team, if it had been available. 

 

Using my definition of the term project, anything you can’t do in a single session 

qualifies for TASK-it project status.   

 

Have you ever found it hard to gather up the energy to clean out and organize a 

closet at home?  As long as you see it as one big task, the tendency is to put it off 

because of the out-of-sight, out-of-mind principle.  You open the closet door, you 

think about how you need to get rid of things, organize the closet and maybe install 

some kind of efficient closet system.  Just thinking about it is uncomfortable because 

you have so many other things to do.  So you close the closet door.  Out of sight, out 

of mind. 
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But it’s never really out of mind.  It’s up there in your head somewhere, along with 

thousands of other nebulous tasks that are too time-consuming and too unpleasant to 

be your highest priorities.  One of the greatest benefits of TASK-it is that feeling of 

control you’ll experience when you have finally entered everything into the system.  

Life just feels more manageable.  And with TASK-it, it is! 

 

But that doesn’t mean the closet will get cleaned out and organized any sooner.  Now 

that it’s in your task list, you’ll be reminded of it more often.  You may even escalate 

its urgency by setting a higher priority and assigning a due date.  But if the due date 

comes and goes (turning the item red in your task list) and it’s still undone, your 

problem may be that you’re trying to manage a project as though it were a task. 

 

Is it possible to clean out and organize the closet in one day?  Yes.  With all your 

other commitments, is it probable that you’ll dedicate an entire Saturday to this task? 

Probably not.  In determining what a single session is for you, it’s important to be 

realistic and consider your typical work habits.  Unless you’re highly focused, I 

recommend that you consider two hours to be the maximum length of a single 

session. 

 

With this in mind, your closet task has just become a project.  Some of the potential 

tasks in this project might be: 

 

 Clean out the junk 

 Get rid of some of the clothes you don’t wear any more 

 Make a plan for your organized closet 

 Make a parts list for a trip to Home Depot 

 Go to Home Depot and buy everything you need 

 Install your new closet organizer system 

 Organize everything within your new closet 

 

As long as you look at “clean out and organize the closet” as one big task your mind 

will tend to resist getting started. 

 

Convert Large Tasks into Projects and Give them a Jumpstart 
 

The best way to avoid the procrastination habit is to convert the task into a Jumpstart 

task within a new project.  Simply create a new project category: “P: Bedroom 

Closet.”   Then change the subject of your task to “Jumpstart Bedroom Closet 

Project.”   
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What is a jumpstart?  A project jumpstart is a task in which you focus on your project 

and do as much planning (and possibly execution) as you can in 30 minutes.  The 

only thing that you absolutely must accomplish during your jumpstart task is to enter 

the next task within the project that you intend to accomplish. 

 

You may end up with a comprehensive task list for the project as a result of your 

jumpstart session.  You may actually complete several small project tasks during the 

session.  But if the project isn’t complete at the end of your session (and it probably 

won’t be), when you click the jumpstart task’s Complete box, your next project task 

should already be in your project list.  Then make sure that although you may not 

have a full project task list for the project, you always finish a project task by creating 

the next task within the project category. 

 

 
Figure 6-1: Tasks within a project 

 

So your “clean out and organize the closet” task becomes a project, and “clean out 

the junk” becomes the second task (after your jumpstart task).  You may find that the 

jumpstart concept gives you a new feeling of freedom when starting new projects, so 

that you accomplish more than expected during the jumpstart task.  If you actually 

clean out the junk during the jumpstart, you can create a “get rid of old clothes” task 

as your next task in the project.   

 

In this way when you review your tasks and projects, you will be less likely to fall into 

the procrastination habit.  How do you eat an elephant?  Turn it into a project and 

TASK-it! 
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Setting up a Project Template 
 

If your work includes frequent projects with the same or similar tasks, you can create 

TASK-it project templates.  Each project template will be saved as a set of tasks in a 

Tasks subfolder.  For example, if I schedule a workshop for ABC Company, my tasks 

will typically include: 

 

 Send Contract 

 Send Invoice 

 Send Final Outline 

 Buy Airline Tickets 

 Book Hotel 

 Book Rental Car 

 Develop PPT First Draft 

 Develop PPT Final 

 Develop Workbook First Draft 

 Develop Workbook Final 

 Send Assessment Passwords 

 

Although the TASK-it project template process isn’t fully automatic, it’s a great way 

for me to jumpstart a new project.  My project begins after I agree with client ABC on 

a date for the workshop.  At that time I create a new project category: “P: ABC 

Workshop.”  Then I either jumpstart the project or create a Jumpstart task and assign 

the P: ABC Workshop category.   

 

When I sit down for my 30-minute Project Jumpstart task, the first thing I do is copy 

the appropriate set of tasks from my New Workshop template, and with a few minor 

adjustments my project tasks are set up in TASK-it.  Since this process typically only 

takes about five minutes, I still have plenty of time to do some real planning and 

knock out a few of the simple tasks on the list during my Project Jumpstart session. 

 

To set up a TASK-it Templates folder, click on the Folder List icon at the bottom of 

the Navigation Pane and then right click on the Tasks folder in one of your Personal 

Folders.  Select New Folder and make sure Task Item is selected in the Folder 

contains field.  Enter the name TASK-it Templates and click OK. 

 

If you only have one project template, you can create the template tasks directly in 

this folder.  If you have more than one, you can create a subfolder within the TASK-it 

Templates folder for each template.  Create your tasks in the template folder and 

assign the appropriate Action categories.  Include any notes that may be helpful.  

That’s all there is to it. 
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Figure 6-2: Creating a TASK-it Templates folder 

 

When you’re ready to create a new project from a project template, go to the TASK-it 

Template folder, locate the appropriate set of template tasks and copy the tasks 

(highlight the tasks, then select Edit, Copy).  Then go to the main Tasks folder and 

select Edit, Paste.  Because the template tasks do not have category assignments, 

they will appear grouped together as the first items in your Task list.  Now all you 

need to do is to modify the Subject lines of each task and add notes, due dates, 

reminders (if appropriate), and assign categories.   

 

TASK-it is all about getting things out of your head and into your system.  Using 

templates for your similarly structured projects will help reduce your reliance on 

memory when defining new project tasks. 

 

 
When a Task Gets Stalled, Make it a Jumpstart Task 
 

The primary reasons most people procrastinate is because the task is unpleasant, 

unfamiliar, large, time-consuming, complex or boring.  Any time you notice that you 
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seem to be avoiding a task, add the word Jumpstart at the beginning of the task 

subject line. 

 

With a jumpstart task you’re only committing 30 

minutes to the task.  Period.  Anyone can stand 

working with an unpleasant, unfamiliar, large, 

time-consuming, complex or boring task for 30 

minutes.  Jump into it and see what you can do in 

the first 20 minutes.  If it’s clear you can’t 

complete the task in your 30-minute jumpstart 

session, use your final 10 minutes to convert it to 

a project and define your next task in TASK-it.  If 

you follow this simple process, you’ll be amazed 

at how effective you’ll be in completing those 

stalled tasks 
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Chapter Seven: 
Delegating and Monitoring 

 
 
 
 
 
 

 

 

 

“Few things help an individual more than to place 

responsibility upon him, and to let him know that 

you trust him.” 

- Booker T. Washington 

 
 
 
 
 
 

Implicit and Explicit Delegation… and TASK-it 
 
Effective delegation and monitoring of tasks is an essential management skill.  But 
it’s not just for managers, because any time you expect your boss, a coworker or a 
customer to do something an implicit, delegated task exists within your expectations. 
 
The topic of delegation is beyond the scope of this book, but as you’re entering your 
tasks into TASK-it, don’t forget to also enter the tasks that you have explicitly or 
implicitly delegated to others.  Effective delegation requires good solid 
communication with mutual agreement, so the more explicit you can be in describing 
your expectations and getting feedback from the person(s) you’re delegating the task 
to, the better.  But in any case, if you expect it to get done, enter it in TASK-it and 
give it a Due Date. 
 

Dumping and Waiting 
 
Some people confuse dumping with delegating.  Dumping usually implies that you’re 
giving an unwanted task to someone else, with little communication, feedback or 
follow-up.  TASK-it will help you transition from dumping to delegating. 
 
While you’re waiting for someone else to do what you expect them to do, what kind of 
progress are they making?  How do you know?  TASK-it gives you a process for: 
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 Confirming what you expect right after the task is delegated 

 Monitoring the task’s progress 

 Tracking delegated tasks until completion 
 

Confirming What You Expect 
 
Usually tasks are delegated during meetings or phone conversations.  Did everyone 
hear the same thing?  Are you on the same page?  After your conversation, write an 
email to the person(s) you delegated the task to, outlining your conversation, your 
agreements, and what you expect in terms of the actual deliverable and its due date.   
 
Then go to your Outlook Mail Sent Items folder and drag the item to the TASKS 
button or icon in the Navigation Pane.  This opens a task with the same subject line 
as your email.  Modify the subject line as necessary.  The text of your email is in the 
Notes field of your task.  Add any details that may help you to monitor the task.  In 
the Due Date field, enter the expected completion date and set a Reminder for the 
date you would like to check on the status of the task.  Then assign the A: Waiting 
category to the task.  If you don’t have a Waiting category in your Action group, add 
one. 
 

Monitoring the Task’s Progress 
 
Your Waiting list is not designed to make you a micromanager.  It’s designed to help 
you to inspect what you expect.  This was the delegation mantra I was given in my 
initial training as a new manager back in the 70s.  It still holds true today.  Don’t wait 
until the due date to check on the status of an important delegated task.   
 
Use your Task Reminders to remind you to follow up.  When you check on the 
progress of the task, you show the person you delegated it to that it’s important, and 
that you haven’t just dumped it.  In monitoring, you can also add some feedback that 
may improve the quality of the completed task.  
 

Tracking Delegated Tasks until Completion 
 
Just like any task, your delegated tasks remain in TASK-it until completion.  Once 
you know the task is done, you can click the Complete box and it disappears from 
your Waiting list. 
 
Whether you explicitly delegate a task to someone else, or whether you are just 
expecting it to get done, don’t just wait for it.  Create a task and tag it with the Waiting 
category so it doesn’t fall through the cracks. 
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Assigning Tasks to Others through Outlook 
 
Although Outlook gives you the ability to create tasks and assign them to others, I 
recommend that you wait to implement this feature until: 
 

 You have been using TASK-it for at least 90 days 

 The people you assign tasks to are actively using Outlook Tasks 
 
Then, if you begin using this powerful feature, don’t use it as a license to dump 
unwanted tasks on others. 
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Chapter Eight: 
Ideas and Goals 

 
 
 
 

“The best way to have a good idea is to have lots of 

ideas.” 

- Linus Pauling 

 

 

“Goals are not only absolutely necessary to 

motivate us. They are essential to really keep us 

alive.” 

- Robert Schuller 

 
 
 
 
 
 
 
Ideas are like seeds.  They can grow into great accomplishments, but they must be 
planted and watered so they can germinate and grow.  I encourage you to use 
TASK-it as a way of recording and reviewing your ideas so they can germinate and 
grow into goals, projects and completed tasks. 
 

Planting Your Ideas in TASK-it 
 
Several years ago, I came up with the idea of creating a website for each of my areas 
of training (Time Management, Leadership, Conflict Management, etc.).  It seemed 
like a lot of work, and I had no idea if it was worth the effort, but I entered it as an 
idea in TASK-it.  Sometimes great ideas fall by the wayside because they are simply 
forgotten.  When you enter your new idea as a task in the Z: Ideas group, your task 
will not be forgotten. 
 
This year, I converted my website idea into a goal in my Z: Goals category.  Then I 
created a project for each website, and so far I’ve completed eight of those projects.  
If you want to turn your ideas into realities, start by entering them into TASK-it. 
 
If you have a lot of ideas, you can create Ideas Categories within the Ideas Group, - 
such as Inventions, Songs, Poems, Business Ideas, etc.  In my case, I put all ideas in 
a single list under the Z: Ideas Group.  
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Germinating Ideas through Monthly Review Sessions 
 
During your monthly review session, you will review all your TASK-it lists, including 
your Ideas and Goals.  Whether you actually do anything with your ideas is not as 
important as simply remembering and periodically reviewing them.  Your mind will do 
the rest automatically.  This process keeps your ideas alive in the stream of your 
mind, and allows them to germinate and grow.  As they grow, some ideas will prove 
to be impractical, uninteresting, or irrelevant. Some ideas, however, will catch your 
attention as they grow, and you will begin to catch a vision for how valuable they 
really are.   
These valuable ideas have great potential for growing into important goals. 
 

Converting Ideas into Goals and Projects 
 
A Goal is a valuable idea that you have developed a vision for.  You can visualize the 
end result and you’re willing to put forth the effort to make it a reality.  All it takes to 
convert an Idea into a Goal in TASK-it is to uncheck the Z: Ideas Category and check 
the Z: Goals Category for the task.  It only takes a second, but in doing it, you’re 
saying, “I will achieve this goal.”  If you’re not ready to say it, leave it as an Idea. 
 
When you convert the Idea into a Goal, you’re stating your intention to achieve the 
goal, but there are still questions about how and when you’ll achieve it. Depending on 
the magnitude of the goal, it may take a lot of planning and consideration.  The Notes 
section of the Goal task gives you plenty of room to develop your plan, strategy and 
milestones for achieving the goal.  When you’re actually ready to move from the 
planning to the action stage, you’ll create one or more projects in your Projects 
group.  The single Goal task in the Goals group will outline the details of the goal, but 
the project(s) in the Projects group will contain the actually tasks for getting the job 
done. 
 

Completed Tasks and the Feeling of Accomplishment 
 
As you work with TASK-it in capturing ideas, converting them to goals and then 
accomplishing those goals through effective task management, you will begin to fully 
realize the true value of TASK-it.  It can make the difference between just having 
good ideas, and actually creating a new reality for your life. 
 
When you come up with a new idea, don’t just dream about it; TASK-it!
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Chapter Nine: 
Configuring & Using the To-Do Bar 

 
 
 
 
 
 
 
 
 

“I long to accomplish great and noble tasks, but it is 

my chief duty to accomplish humble tasks as 

though they were great and noble. The world is 

moved along, not only by the mighty shoves of its 

heroes, but also by the aggregate of the tiny 

pushes of each honest worker.” 

- Helen Keller 

 
 
 
 
 
If your days are typically filled with appointments, you may find it cumbersome to 
toggle between Outlook’s Calendar and Tasks functions.  But Microsoft has given 
you a great solution:  The To-Do Bar. 
 

The Outlook To-Do Bar 
 
The To-Do Bar displays your Tasks on the right side of the Outlook screen, and can 
be selectively turned on or off within each primary Outlook function (Mail, Calendar, 
Contacts and Tasks). Displaying the To-Do Bar in Tasks is redundant, so you can 
easily turn it off by clicking the X in the top corner of the To-Do Bar in your Tasks 
view. 
 
If you turn the To-Do Bar off in any of the Outlook primary functions, it will remain off 
in that function until you turn it on again.  To turn the To-Do Bar on within Mail, 
Calendar or Contacts, click the View pull-down menu and select To-Do Bar.  Then 
select Normal.  When the To-Do Bar is turned on in Mail, Calendar or Contacts, you 
can minimize it or maximize it by clicking the double arrows at the top of the To-Do 
Bar. 
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Figure 9-1: The Outlook To-Do Bar displayed with the Calendar view 

 

Customizing the To-Do Bar 
 
You can customize the To-Do Bar to display tasks only, or to include a monthly 
calendar navigator and/or your appointments in addition to your tasks.  You can also 
customize the To-Do Bar so that it displays your tasks exactly like the TASK-it View 
described in Chapter 3.   
 
To define which of the three To-Do Bar elements are displayed (Date Navigator, 
Appointments and Task List), click on View tab in the Ribbon and in the Layout 
section, select To-Do Bar.  Then check the elements you want to display.  If you 
check Date Navigator and/or Appointments, you can also select Options to specify 
how many rows of Date Navigator months and how many appointments to display 
within the To-Do Bar.  
 
To customize the To-Do Bar to display the TASK-it View, right click on the To-Do Bar 
Task Field Label Header (the line that displays the task field names) and select View 
Settings.  This displays the Advanced View Settings: To-Do List dialog box, from 
which you can change the same four settings you changed in creating the TASK-it 
View in Chapter 3: 
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 Group by Categories 

 Display the columns you want to see  

 Sort the tasks within each category  

 Filter completed tasks  

 

Group your To-Do Bar Tasks View by Category 
 

From the Advanced View Settings: To-Do List dialog box, select Group By.  Then 

select Categories from the Group Items By drop-down box, make sure Ascending is 

selected and click OK. 

 

Display the Fields You Want to See 
 

Select Columns from Advanced View Settings: To-Do List dialog box and select All 

Task Fields from the Select available fields from drop-down box.  Then use the Add 

and Remove buttons to place only the fields you want to see in the Show these fields 

in this order box (Complete, Priority, Task Subject and Due Date).  Then use the 

Move Up and Move Down buttons to arrange them in order. 

 

Add the Priority and Due Date fields by clicking on each one in the Frequently-Used 

Fields list and then clicking Add.  The Complete and Subject fields should already 

appear in the Show these fields in this order list.  Then use the Move Up and Move 

Down buttons to place them in this order: 

 

 Complete 

 Priority 

 Subject 

 Due Date 

 

Remove any extra fields with the Remove button. 

 

The To-Do Bar displays your tasks in Compact Mode, so you may not see all the 

fields unless you select 2 as the Maximum number of lines in compact mode at the 

top of the Show Columns dialog box. 

 

When you have made all changes, click OK. 
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Sort the Tasks within Each Category  
 

Click the Sort button on the Advanced View Settings: To-Do List dialog box and 

select Due Date (Ascending) from the Sort items by drop-down menu.  Select Priority 

(Descending) from the first Then by drop-down menu. Then click OK. 

 

Filter Completed Tasks  
 
Select Filter from the Advanced View Settings: To-Do List dialog box and click on the 
Advanced tab.  Click the Field button and select Complete from the Frequently-used 
fields list.  Make sure that Equals is selected for Condition and No is selected for 
Value.  Then click the Add to List button and OK.  Click OK in the Customize Current 
View dialog box and your To-Do Bar is set up for TASK-it. 
 
Your customized settings will apply to the To-Do Bar wherever you choose to use it 
(in Mail, Calendar and/or Contacts). 
 

The Outlook Calendar’s Daily Task List  
 
At the bottom of your daily calendar is the Daily Task List, which allows you to display 
tasks at the bottom of your daily calendar.  This feature is of minimal help because of 
the limited customization options.  To display the Daily Task List, click the View tab in 
the Ribbon in Calendar and then select Daily Task List from the Layout section of the 
Ribbon.  Select Normal to display your tasks at the bottom of your daily calendar.  
Select Arrange by to choose whether you want do display tasks by due date or start 
date, and whether to display completed tasks.   
 
Although you can’t arrange tasks by category, each task is displayed in the color of 
the first category assigned.  If you elect to display the Daily Task List, you can click 
the directional arrow button on the top line to minimize or restore the list. 
 
The To-Do Bar and Daily Task List can be helpful tools in allowing you to integrate a 
view of your tasks into the Mail, Calendar and Contacts functions of Outlook 2010. 
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Chapter Ten: 
Getting All Your Tasks into TASK-it 

 

 

 

 

 

 

 

 

 

“I know the price of success: dedication, hard work, 

and an unremitting devotion to the things you want 

to see happen.” 

    - Frank Lloyd Wright 

 

 

 

 

 

 

 

Now that your TASK-it system is up and running, your challenge is to get all your 
tasks into the system.  The faster you can accomplish this project, the better.  But 
effective use of TASK-it requires more than just getting tasks into the system.  It 
requires a different way of managing your things. 
 

Managing Your Things 
 
Everyone has things.  Some people focus their entire lives on the accumulation of 
things, only to give them all up in the end, because you can’t take them with you.  But 
during your life, things do play a major part in your activities, your occupation and 
your preoccupation.  Much of the stress we experience is due to our mind’s 
preoccupation with things.  Every thing you bring into your life adds to the clutter and 
to the maintenance you must perform.   
 
If you buy a sailboat, for example, you may have a really great thing, but you must 
consider all that it takes to manage that thing.  Where will you keep it when you’re not 
sailing?  What kind or registration will be required?  Will you have to pay personal 
property tax on it each year?  What kind of maintenance will you have to perform on 
the boat, sails and other gear?  The tasks required to maintain a sailboat should be 
considered along with the rest of your buying decision criteria. 
 



 

 

Chapter Ten: Getting All Your Tasks into TASK-it 

 

 

 
62 

Tasks are inherent in every thing you own or manage.  Those tasks aren’t always 
immediately apparent, but your mind tries to consider them, and often gets 
overwhelmed in the process.  TASK-it will take relieve your mind of the burden of 
task management.  But this is only possible if you learn how to effectively manage 
your things by organizing them and entering their inherent tasks into TASK-it. 
 
Figure 10-1 below is the Managing Your Things flowchart, and it depicts the process 
for managing your things while entering their inherent tasks into TASK-it.  You will 
use this in the process of entering your existing tasks into TASK-it, and you will 
continue to use the process on an ongoing basis as new things enter your life. 
 
The concept is simple.  You pick up a thing from your inbox or from one of the piles 
on your desk, and you ask this question, “Is action required?”  If the answer is no, 
you ask a second question, “Do I need it?”  If the answer is no, toss it.  Why over-
burden yourself with things you don’t need? 
 
 

 
Figure 10-1: Managing Your Things flowchart 

 

If the answer to the “Do I need it?” question is yes, then ask the question, “Does it 

have a place?”  The assumption here is an important one:  Managing things means 
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“A place for everything and everything in its place.”  This motto is absolutely essential 

for effective thing management.  So if the answer is yes, put the thing in its place.  If 

the answer is no, make a place for it and then put the thing in its place. 

 

The track through the flowchart that we just discussed is what you will do when the 

thing you pick up has no inherent tasks.  This is determined by the answer to the 

question, “Is action required?”  When the answer is no, there is no inherent task, and 

there is nothing to enter into TASK-it. 

 

If the answer is yes, there is at least one inherent task.  The next question you will 

ask yourself is “Does it require immediate action?”  If the answer is yes, then do it 

now.  No need to enter it into TASK-it because if you do it now, the task is done.  

Then ask the question, “Do I need it?” and either toss it or put it in its place. 

 

Here’s where TASK-it comes in.  If the answer to the question “Is immediate action 

required?” is no, then enter the task into TASK-it.  Then ask, “Does it have a place?” 

and put it there.   

 

Papers need to be filed.  Things need to be put in their places.  Some people keep 

them stacked in plain view as a reminder that there are tasks associated with the 

papers and things, and these tasks need to be done.  This is an extremely inefficient 

task management system.  Extract the tasks, enter them into TASK-it and put the 

things away! 

 

If you follow the process outlined by the flowchart, you will make effective use of 

TASK-it, and your things will be effectively managed.  So to get started, it’s time to 

catch up on your unmanaged things and your undone tasks. 

 

Your “Enter All Tasks” Project 
 

The best way to get going with task and thing management is to set up an Enter All 

Tasks project.  Don’t just think about it, do it.  Begin now, by setting up the project, P: 

Enter All Tasks.  In setting it up, enter the following tasks: 

 

 P: Enter All Tasks – Jumpstart 

 P: Enter All Tasks – Physical Inbox 

 P: Enter All Tasks – Outlook inbox 

 P: Enter All Tasks – From My Desk 

 P: Enter All Tasks – From My Workspace 

 P: Enter All Tasks – From My Home 

 P: Enter All Tasks – From My Head 
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If you can dedicate the next few days to completing this project, do it.  If you can’t, 

make it a priority and do it as quickly as you can.  Until you complete this project, you 

haven’t completed your transition to TASK-it. 

 

Enter All Tasks – Jumpstart 
 

Start your project with a 30-minute Jumpstart task.  I’ve outlined six additional tasks 

for the project, based on obvious places to look for tasks.  When you actually do your 

jumpstart task, decide which of the remaining tasks you will tackle next and assign an 

appropriate due date.  Use the rest of your 30-minute Jumpstart session to create 

additional tasks for any other task sources you can think of.  Don’t overlook closets, 

drawers, cabinets, bookshelves and storage rooms.   

 

If you plan to include your personal tasks (which I highly recommend), create tasks 

for obvious locations at home, including your home office physical inbox, desk, 

bookshelves, closet, floor, etc.  Then consider the rest of the house and all the 

undone projects you’ve been thinking about.  Create tasks associated with physical 

locations including each room of your house, your attic, garage and yard.  You may 

also want to create tasks corresponding to specific areas of interest, such as Art, 

Music, Golf, Fishing, Health, etc.  The idea is to create a task for any possible area 

where potential tasks may be hiding.  As you complete these tasks, other task areas 

may come to mind.  As they do, create additional tasks in your Enter All Tasks 

project. 

 

Enter All Tasks – Physical Inbox 
 

If your physical inbox is piled high with papers and other incoming things, make your 

inbox the next task after your Jumpstart.  Since a task is something you complete in a 

single session, don’t turn this task into a project by pondering each inbox item or 

attempting to do it (unless it is absolutely necessary to do it now).  Use the Managing 

Your Things flowchart (figure 10-1) to guide you through the process. 

 

If you are unable to complete this task in a single session, make sure you scope the 

size of the remaining task(s) and enter it (or them) into TASK-it immediately.  Part of 

the skill of effective task management is the ability to accurately estimate how long it 

will take you to complete a task.  You’ll get better at this skill with experience. 
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Enter All Tasks – Outlook inbox 
 

Your Outlook inbox is not a task list.  It’s a collection of unmanaged things.  If you are 

like many Outlook users, you have hundreds or even thousands of old emails in your 

inbox.  This is a highly ineffective way of using Outlook.  Now that you have TASK-it, 

you can change your ways. 

 

To help you manage your Outlook inbox, I’ve provided a second flowchart, 

specifically for this purpose (figure 10-2).  Use the Managing Your Email flowchart to 

quickly go through your Outlook email inbox, deleting or filing each email as you go. 

 

Deleting emails you don’t need is easy.  Just place your cursor on the item and click 

the X on the toolbar or press the Delete key.  The place for processed emails is not 

your Outlook inbox, so if you don’t have a place for them you’ll need to create a 

place. 

 

 
Figure 10-2: Managing Your Emails flowchart 
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The best place to file processed emails is within appropriately named subfolders. If 

you are using Microsoft Exchange and have a limit to the number or volume of emails 

you can save on the Exchange Server, this will eliminate the frustrating problem of 

running out of space.  You will create your email subfolders within an Outlook 

Personal Folder (.pst file) on your computer’s local hard drive. 

 

 
Figure 10-3: Creating an email subfolder 

 

If you are using Outlook as a standalone system, you aren’t using an Exchange 

Server, and all your Outlook files are already being saved in a Personal Folder.  In 

either case, you can create your subfolders by clicking on the Folder List button or 

icon at the bottom of the Navigation Pane.  This displays all your Outlook folders.  To 

create a subfolder, right click on the Inbox folder under your Personal Folder and 

select New Folder. Then enter the folder name in the Name field.  Make sure Mail 

and Post Items is selected in the Folder contains field and click OK. 

 

Now, to move an email item from your inbox into its new place in the appropriate 

subfolder, just drag the item into the folder in the Navigation Pane.  Having 
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everything in the right place will make email management much easier, and if you 

don’t remember where you filed an email item it’s not a problem, because you can 

use the search feature to search all your folders and find the email with lightning 

speed.  To set Outlook Mail to search all mail folders as the default, click in the 

search window at the top of your Mail view.  This displays the Search Tools tab in the 

Ribbon.   Select Search Tools in the Options section of the Ribbon and then select 

Search Options.  In the Results section of the dialog box, select All Folders and then 

click OK.  If you’re using the Windows 7 or Vista, that’s all you need to do.  If you’re 

using Windows XP, you’ll need to download and install the free Microsoft utility, 

Windows Search 4.0.  This utility gives you the fast context search capability that is 

built into Windows 7 and Vista.  

 

If it makes you nervous to move your emails out of your familiar inbox into a new and 

unfamiliar location, do it anyway.  Any new process will feel unfamiliar at first.  This 

new process for managing your emails will give you a feeling of freedom and 

accomplishment, especially when you finally get the item count in your email inbox 

down to zero.  Keep it there.  The only reason to have any items in your inbox is 

because you haven’t read (processed) them yet.  Actually you don’t need to read an 

email to process it.  You can usually tell by the Subject and From fields whether you 

want the email or not.  Learn to delete your junk mail quickly.  Then use the 

Managing Your Email flowchart to make email management a breeze. 

 

Remember, you can drag any email that contains an inherent task to the Task button 

or icon in the Navigation Pane to convert it into a task.  Just change the Subject line, 

adjust the fields appropriately and tag it with the appropriate category (or categories).  

Your email item remains in your inbox after you create a task, so don’t forget to 

delete it or file it in a subfolder to process it completely. 

 

Enter All Tasks – From My Desk 
 

Some people use Pile Management techniques to manage things and tasks.  Now 

with TASK-it and the Managing Your Things flowchart, you can eliminate your piles 

and effectively manage the tasks that are hiding within.  Your P: Enter All Tasks – 

From My Desk task includes cleaning out your desk drawers.  If this is more than you 

can do in one session, break it down into smaller tasks and go for it! 

 

Enter All Tasks – From My Workspace 
 

Once you’ve processed your inbox and your desk, it’s time to go through the rest of 

your office or cubicle and put everything in its place while extracting the inherent 

tasks and entering them in TASK-it.  Don’t leave any stone unturned. 
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Enter All Tasks – From My Home 
 

You may have piles of work in your office at home.  After you finish with your office, 

process all your work-related tasks in your home office and in the rest of your house 

or apartment.  Don’t forget to include your personal tasks.  This will probably require 

you to break this task in to a number of smaller, more manageable tasks. 

 

Enter All Tasks – From My Head 
 

Finally, last but not least, it’s time to deal with the tasks stored in your head.  By this 

time, you’ve already cleared quite a lot from your head, because your brain has been 

in the habit of trying to manage all the tasks in your office and home.  Now that most 

of them have been entered into TASK-it, your mind is much clearer so you can deal 

with the task at hand, whatever it may be. 

 

But there are still a lot of tasks in your head.  This task is a brainstorming session, 

during which you will try to bring any remaining tasks to mind and enter them into 

TASK-it.  Use the Managing Your Shoulds flowchart (figure 10-3) to help you through 

the process, and the ongoing process of keeping your head clear. 

 
Your mind is very good at generating Shoulds.  Shoulds are thoughts about what you 
should do.  These thoughts don’t just come at the time when you need to perform the 
task.  They’re generated at random, and often in large numbers, so you feel 
overwhelmed by the sheer volume of all you have to do. 
 
Now that you have TASK-it, you don’t need to be driven by shoulds.  You can 
effectively manage all your tasks through your highly effective external support 
system.  Any time your mind assaults you with shoulds, refer to the Managing Your 
Shoulds flowchart. 
 
Listen to each should only once.  Ask the question, “Is action required?”  If the 
answer is no, ask yourself whether it’s important.  If the answer is no, then just forget 
about it.  If the should returns to haunt you, ignore it.  If you aren’t used to ignoring 
your unimportant shoulds, it’s a valuable skill to learn.  Some people think they’ve 
mastered this skill through procrastination.  Unfortunately, the procrastination habit is 
often the source of your shoulds.  When you follow the Managing Your Shoulds 
flowchart, you’re managing your responsibilities and ignoring the mind’s worthless 
chatter. 
 
If action is not required, but it’s important, then maybe your should is actually an idea 
or a goal.  If so, enter it into TASK-it.  If the should returns, ignore it, because now the 
idea or goal is being managed by your external support system. 
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Figure 10-4:  Managing Your Shoulds flowchart 

 
If you ask the question, “Is action required?”  and the answer is yes, ask yourself if 
immediate action is required.  If the answer is yes, do it now, and you’re done.  
Forget about it. 
 
If action is required, but not immediate action, enter into TASK-it and then forget 
about it.  It’s now under the management of your external support system. 
 
This process is guaranteed to relieve stress and get things done more efficiently than 
your old should-powered system could ever do.  Now use TASK-it and the Managing 
Your Shoulds flowchart to get the tasks out of your head and into your system. 
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Chapter Eleven: 
Creative Tips for Task Input 

 
 
 
 
 
 
 
 
 

“They say that time changes things, but you 

actually have to change them yourself.” 

- Andy Warhol 

 
 
 
 
 
 
 
 
 
Once you’ve completed your Enter All Tasks project from Chapter 10, all you have to 
do is ongoing new task input and maintenance through daily and monthly task 
reviews.  You’ve learned how to input a new task.  Below are tips for a variety of 
creative ways of getting tasks into TASK-it 
 

Creative Tips for Task Input 
 
Some of these tips were outlined in Chapter 4, but this section will give you a full list 
of input options: 
 

 Create a task from an Email item.  While in Outlook Mail, drag the email item 
to the Task button or icon in the Navigation Pane. 

 Create a task from a Calendar item.  While in Calendar, drag the calendar 
item to the Task button or icon in the Navigation Pane. 

 Create a task from a Contacts  item.  While in Contacts, drag the contact 
item to the Task button or icon in the Navigation Pane. 

 Create a task from Windows Explorer or My Documents.  If you’d like to 
create a task from Windows Explorer or My Documents, drag the file to the 
Task button or icon in the Navigation Pane within an Outlook window and 
Outlook will open a task with your file already inserted in the notes field as an 
attachment. 
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 Create a task from your smartphone.  Use the Outlook Sync feature of your 
Android, iPhone, Blackberry or other smartphone.  If Outlook Sync isn’t a 
standard feature, do an Internet search for a third party Outlook Sync utility 
that works with your mobile device. 

 Create a task from your Tablet PC.  Use Microsoft OneNote to take 
handwritten notes with drawings, and convert your notes to an Outlook Task. 

 Create a task from your digital audio recorder.  Most digital audio recorders 
save files in MP3, WMA, WAV, or other formats that can be played on a PC.  
Make audio notes about your ideas, goals, projects and tasks and copy them 
to your PC and attach them to Outlook tasks.  Since many smartphones 
include voice recording as a standard feature, this process is streamlined with 
Outlook Sync. 

 Create a task from a voice mail.  With services such as CallWave, you can 
add a free digital voice mail service to your home or cell phone (and possibly 
to your work phone) that will automatically send your voice mail message as 
emails with voice attachments.  When you receive your message in your 
email, just drag the item to the Task button or item in the Navigation Pane to 
create a task. 

 Create a task from any phone.  Use the same feature noted above to call 
yourself from any phone and record a task using your voice mail.  Then 
convert the email to a task when you receive it in Outlook later. 

 Create a task from an existing hard copy.  If you have an existing document 
and an inherent task associated with it, use a desktop scanner to scan the 
document and attach it to a task. 

 Create a task from a fax.  Many companies use fax servers that deliver faxes 
as emails.  I receive all my faxes as emails through the free fax-to-email 
service offered by eFax.  I often create tasks from faxes received as emails, by 
dragging them to the Tasks button in the Outlook Navigation Pane. 

 Create a task from Web content.  Right click on the Outlook toolbar and 
select Web to open the Web toolbar.  This toolbar allows you to do Web 
browsing from anywhere in Outlook.  Just use the Web toolbar as your 
browser.  If you find an article you’d like to use as the basis for a task, highlight 
and copy it, then click the Tasks button and open a task.  Then paste your 
Web text into the Notes field of the task. 

 Create a task from your notepad.  This may seem obvious, but if you don’t 
have your smartphone with you and you want to enter a task, use a notepad or 
a napkin initially, and enter it into TASK-it at your earliest convenience.  You’re 
not trying to work from stray notes and napkins.  You’re working from TASK-it, 
but using a temporary means of getting the task out of your head as quickly as 
possible. 

 Create a task while you’re in the shower.  A participant in one of my recent 
time management workshops told me about a white board for your shower.  I 
bought one immediately after the class.  It’s great!  If you get great ideas in the 
shower, don’t take the chance of forgetting them.  Write them down while 
you’re in the shower and then transfer them to TASK-it at your earliest 
convenience. 
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 Create recurring Tasks.  If you have routine tasks that you have to do daily, 
weekly or monthly, create recurring tasks to have these tasks generated 
automatically.  See Chapter 4 for instructions on creating a recurring task. 

 
Discover your own creative techniques for getting ideas, goals, projects and tasks 
into your TASK-it system! 
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Chapter Twelve: 
Staying Committed 

 
 
 
 
 
 
 
 
 

“This loving person is a person who abhors waste--

waste of time, waste of human potential. How much 

time we waste. As if we were going to live forever.” 

    - Leo Buscaglia 

 
 
 
 
 
 
TASK-it will grow on you.  As you use it, your ideas will grow and expand, you’ll 
become more goal-oriented, and you’ll accomplish more than ever before.  You’ll 
grow to rely on your external support system as it helps you to keep your 
commitments and manage the details of your work and personal life. 
 

Moving Past the Dips: Making TASK-it a Habit 
 
In spite of all that, you will occasionally find yourself in the “dip” state, as I mentioned 
in the introduction to this book.  My recommendation is to simply stay committed. 
 
If you notice that you haven’t been using the system, don’t use that as an excuse to 
chuck it.  Just start using it again.  When you catch yourself writing a task on a sticky 
note, just stop it and enter it into TASK-it.  Even if months go by during which you 
haven’t used the system at all.  Just go back and pick up where you left off.  Sooner 
or later your subconscious mind will realize that TASK-it is here to stay.  If you refuse 
to stop using it, your new system will replace your old one and it will become a habit. 
 

The Revolution and the Evolution of TASK-it 
 
For most people who implement it, TASK-it is a revolutionary approach to task 
management compared to their former methods of getting things done.  Because of 
Outlook’s flexibility, you can continue to adapt TASK-it to your work style by evolving 
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your configuration as you go along.  You’ll discover new features hiding within 
Outlook that can make your task management efforts more effective. 
 
Challenge yourself with new technology from time to time.  If you don’t currently use 
a PDA or smartphone, maybe TASK-it will be the impetus you need to take the leap 
into mobile computing.  If you’re considering a new laptop, maybe a Tablet PC is the 
right choice.  The scope of the benefits you will derive from TASK-it is only limited by 
your creativity in evolving its use to fit your needs. 
 
As long as you live, there will always be more to do.  Commit yourself to doing the 
right things and doing them well, and commit yourself to a system that supports you 
in your efforts.  Good luck! 
 
 


